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1. About Kernel for VHD 

1.1 About the Manual 

Welcome to the user manual of Kernel for VHD which is an output-driven tool that repairs corrupted or 
damaged Virtual Hard Disk files and recovers data from them. This user manual helps in guiding the users 
about using the tool efficiently. It is recommended that novice as well as experienced users should 
carefully go through this user manual before using the software. A user who is well aware of the software 
can even use table of contents for finding the particular portion of manual. The table of contents enlists all 
the sections described in this manual from where one can navigate through different sections of this user 
manual. The user manual consists of step-by-step guidelines for using Kernel for VHD. The user manual 
consists of the following sections: 

 About Kernel for VHD 

 Getting started with the User Interface 

 Install and Uninstall 

 Using Kernel for VHD 

 Download Purchase and Register 

 Troubleshooting 

 Legal Notices 

 

1.2 Introduction to Kernel for VHD 

Kernel for VHD is an advanced, effective, and powerful tool that repairs corrupted, damaged or 
inaccessible VHD files accurately and flawlessly. The utility supports VHD files created using Windows 8, 
Windows 7, Windows Server 2008 R2 and Hyper-V Server. The software comprises of three powerful 
recovery modes for recovering data that got lost due to various reasons. The software preserves the data 
integrity, formatting and properties while recovering. 

VHD files may get corrupted due to various reasons such as virus attacks, RAID failure, accidental 
damage due to fire or water, hard disk crash, damaged storage media, unintentional deletion of data 
stored in hard disk, and so on. Kernel for VHD uses powerful algorithms for restoring the lost or deleted 
data and is fast, simple and easy-to-use software.  

 

1.3 Salient Features 

Key features of Kernel for VHD are: 
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 Recovers data from lost, deleted, inaccessible, corrupted or damaged VHD files. 

 Recovers all types of data such as image files, video files, audio files, database files, documents, 
media files, archives, etc. 

 Resolves all types of corruption issues in VHD files. 

 Provides three powerful recovery modes-Quick Scan, Extensive Scan, and File Trace for 
recovering data. 

 Provides options to quickly search partitions of VHD file. 

 Users can show or hide the progress of data retrieving process. 

 Supports recovery of data from VHD files created using Windows Server 2008, Windows Server 
2008 R2, Hyper-V Server, Windows Vista, Windows 7, and Windows 8. 

 

1.4 System Requirements 

The computer system must have the appropriate configuration before installing and running Kernel for 
VHD. Following are the minimum system requirements that a system should possess for successfully 
installing the Kernel for VHD software.  

Basic System Requirements 

 Pentium Class Processor 

 64 MB RAM (128 MB recommended) 

 10 MB of free disk space for software installation 

Supported Windows OS Platforms 

 Windows 8 

 Windows 7 

 Windows Vista 

 Windows XP 

 Windows 2000 

 Windows 2003 

 Windows Server 2008/R2 
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2. Getting started with the User Interface 

2.1 Welcome Screen 

Now, you have got clear idea about the features of Kernel for VHD, so it’s the time to get acquainted with 
the working of the tool. When you install and run Kernel for VHD, following welcome screen appears: 

 

Figure 2.1: Welcome Screen 

 

2.2 Menu Bar 

      The Menu bar of Kernel for VHD comprises following four menus: 

 Recovery Menu 

 View Menu 
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 Tools Menu 

 Help Menu 

 

 

Recovery Menu 

Recovery menu of the Kernel for VHD software appears, as shown in the following figure: 

 

Figure 2.2: Recovery Menu 

Following table enlists the options available in the Recovery menu: 

Option Description 

Open Select this option to add corrupt VHD file to the application. 

Recover Selected Select this option to start the process of saving the recoverable 
data. 

Save Recovery Snapshot Select this option to save the recoverable data as snapshot when 
you do not have time to sit and wait for the data to be saved on your 
computer’s hard disk or another storage media. 

Load Recovery Snapshot Select this option to load the saved snapshot. 

Exit Select this option to close the software. 

 

View Menu 

The View menu allows changing the pattern of viewing the recovered files in the software. View menu of 

Kernel for VHD software appears, as shown in the following figure: 

 

Figure 2.3: View Menu 
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Following table enlists the options available in the View Menu: 

Option Description 

Icons Select this option to view the recovered files in form of icons. 

List Select this option to view the recovered files in a list-like structure. 

Details Select this option to view the recovered files with complete details such as size, 
type, date, etc. 

 

Tools Menu 

Tools menu of Kernel for VHD software appears, as shown in following figure: 

 

Figure 2.4: Tools Menu 

Following table enlists the options available in the Tools menu: 

Option  Description 

Find Files  Select this option to find specific file(s) from the recovered file(s). For 
example, if you need to view .xls files, then type *.xls in “Find Files” dialog box 
and the software will display all the MS Excel file(s) amongst the recovered 
files.  

File Filters  This option works similar to the Find Files option. However, the only 
difference among both is using the Find Files option, you can search for a 
specific type of file, say *.xls but with the File Filters option, you can specify 

multiple file types, say *.xls, *.docx, *.pdf, etc. Based on the file type(s) you 
specify, the software displays the recovered items.  

Settings Select this option to configure following software settings based on which the 
software will search the lost files and folders: 

 Sectors to be read in one attempt.  
 Rename, overwrite, or skip the duplicate files. 
 Include deleted files in the search, exclude deleted files from 

recovered files, or only recover the deleted files. 

Drive Information  Select this option to gather information about the system drive. 

 

Help Menu 
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Help menu of the Kernel for VHD software appears, as shown in following figure: 

 

Figure 2.5: Help Menu 

Following table enlists the options available in the Help menu: 

Option  Description 

Help Select this option to view Help manual of the software. 

About Kernel for VHD  Select this option to view version information and software support details 
of the software.  

2.3 Tool Bar 

Tool bar consists of buttons that work as shortcuts for various options available in the main menus of 
Kernel for VHD software. Following table enlists the buttons available on the Tool bar of the software:  

Button Button Name Description 

 

Recover Click this button to start the saving process. 

 

Save Snapshot Click this button to save the recovery snapshot. 

 

Load Snapshot Click this button to load the recovery snapshot. 

 

Find Click this button to enter and search specific file types 
amongst thousands of file(s) recovered by the software.  

 

Setting Click this button to view and modify following software 
settings based on which the software will search the lost 
files and folders: 

 Sectors to be read in one attempt  
 Rename, overwrite, or skip the duplicate files  
 Include deleted files in the search, exclude deleted 

files from recovered files, or only recover the 
deleted files  

 Number of retries on bad sectors  

 

Buy Online Click this button to purchase the software online. 

 

Help Click this button to view Help manual of the software. 

 

2.4 Buttons Used 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

There are several buttons used in the software that helps user throughout the recovery process. Following 
table lists the buttons used in the software: 

Button Description 

 

Click this button to start the saving process. 

 

Click this button to hide the searching process. While 
searching for the files and folders on the selected hard disk 
partition or logical disk drive, the software displays the 
progress. If you do not want to see that progress then just 
click the “Hide Progress” button. Clicking the “Hide 
Progress” button also improves the recovery speed. 

 

Click this button to view the searching progress. 

 

Click this button to proceed to next step during the recovery 
process. 

 

Click this button to navigate back during the recovery 
process. 

 

Click this button to stop the searching or saving process in-
between. 
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3. Install and Uninstall 

3.1 Install Kernel for VHD 

The software can be installed by following few simple steps. However, before doing so, you need to ensure 
that the software installer file is available with you. If it is not available, it can be downloaded from the site 
http://www.nucleustechnologies.com/vhd-recovery.html 

 
After downloading the installer file, execute the following steps for installing the software: 

1. Double- click Kernel for VHD installer file.  
2. Follow the on-screen instructions. When the installation process completes ‘Setup Installation 

Complete’ message appears on the software installation screen.  
3. Click the Finish button to launch the software.  

After the completion of software installation process, a shortcut to start the software will be added in the 
Windows Start Program menu. User can start the software from Program menu. One can also create 
desktop icon of the software where from it can be started by double clicking the icon. 

 

3.2 Uninstall Kernel for VHD 

User can uninstall Kernel for VHD software from computer system by using one of the following two 
methods: 

 Uninstall from Windows Start menu 

 Uninstall from Control Panel 

 Note: Before starting the un-installation process, make sure that the Kernel for VHD 

software is not in use. 

 
 

Uninstall from Windows Start menu 

  
Execute the following steps to uninstall Kernel for VHD from Windows Start menu: 

1. Click Start > All Programs > Kernel for VHD > Uninstall Kernel for VHD. A warning message 
before uninstalling the software will be displayed on the screen. 

2. Click Yes button to uninstall the software. 

3. Click the OK button. 

 

Kernel for VHD is successfully uninstalled from computer system. 

http://www.nucleustechnologies.com/vhd-recovery.html
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Uninstall from Control Panel 

 
Execute the following steps to uninstall Kernel for VHD from Control Panel: 

1. Click Start > Control Panel. The Control Panel window appears. 
2. Double-click the Add or Remove Programs icon. A list of the programs installed on the computer 

system appears. 
3. Select Kernel for VHD and click the Remove button.  A warning message before uninstalling the 

software will be displayed on the screen. 
4. Click the Yes button to uninstall the software. 
5. Click the OK button.     

 

Kernel for VHD is successfully uninstalled from the computer system. 
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4. Using Kernel for VHD 

Kernel for VHD provides three extensive file recovery modes which recover corrupted, inaccessible or 
damaged VHD files. The recovery modes are as follows: 

 Quick Scan 

 Extensive Scan 

 File Trace 

4.1 Recover Data Using Quick Scan Mode 

The Quick Scan mode is the fastest recovery mode and resolves minor corruption issues in VHD files stored 
in the hard disk of the computer. Execute the following basic steps to recover data using Quick Scan mode. 

1. Click Start > All Programs > Kernel for VHD > Kernel for VHD to launch the software. The welcome 

screen of the software appears. 

2. Browse and select the VHD file. 

 

Figure 4.1: Selecting VHD File for Quick Scan Recovery Mode 

3. Select Quick Scan mode. The Quick Scan interface appears. 

4. Select Virtual Hard Disk from the left panel of the window. The detail of the virtual hard disk is shown in the 
right panel. 

5. Click Next to continue the recovery process. 
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Figure 4.2: Selecting Drive to Recover for Quick Scan Recovery Mode 

 

A dialog box is displayed. Select the radio button Use existing partition info to recover data from an existing 
partition on the selected hard disk. Else, select Search partition option. 

6. Click OK to continue. 

The partition searching process takes place. You can stop the process in between by using the Stop button. The 
available partitions are displayed in the left panel. 
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Figure 4.3: Selecting the Partition for Quick Scan Recovery Mode 

 

7. Select any partition displayed in the left panel of the window. You can view the details of the partition by 
clicking it. 

8. Click Next. The folder searching process is executed. 

 Note: You can show or hide the progress of the search process by clicking the Hide 

Progress/ Show Progress buttons. 

When the search process completes, all the folders are enlisted in the left panel. You can expand the folders 
and view their details displayed in the right panel. 

9. Select and check the folders which you want to recover. 

10. Click Recover button. 

The software displays a dialog box asking you to provide the location for saving the recovered files. 
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Figure 4.4: Selecting Folder to Recover for Quick Scan Recovery Mode 

 

11. Specify the location to save the selected items and click OK button. 

When the saving process is done, the software displays a dialog box containing message regarding successful 
saving of files. 
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 Figure 4.5: Displaying successful saving of files for Quick Scan Recovery Mode 

 

12. Click OK button to close the dialog box. 

You can view the recovered files from the specified locations. 

 

4.2 Recover Data Using Extensive Scan Mode 

The Extensive Scan Mode is the powerful recovery mode that performs intensive scanning of the corrupted or 
damaged VHD files. This mode can effectively recover the files that cannot be recovered by Quick Scan mode. 

Execute the following steps to recover data using Extensive Scan mode: 

1. Click Start > All Programs > Kernel for VHD > Kernel for VHD to launch the software. The welcome screen 

of the software appears. 

2. Browse and select the VHD file. 
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Figure 4.6: Selecting Recovery Mode for Extensive Scan Mode 

 

3. Select Extensive Scan mode. The Extensive Scan interface appears. 

4. Select Virtual Hard Disk from the left panel of the window. The detail of the virtual hard disk is shown in the 
right panel. 

5. Click Next to continue the recovery process. 

A dialog box is displayed. Select the radio button Use existing partition info to recover data from an existing 
partition on the selected hard disk. Else, select Search partition option. 

6. Click OK to continue. 
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Figure 4.7: Selecting partitions for Extensive Scan Mode 

 

The partition searching process takes place. User can stop the process in between by using the Stop button. 
The available partitions are displayed in the left panel. 

7. Click Next. 

8. Select the File System from the left panel of the window. 

9. Click Next. 
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Figure 4.8: Customizing the settings for Extensive Scan Mode 

 

The folder searching process is executed. 

 Note: You can show or hide the progress of the search process by clicking the Hide 

Progress/ Show Progress buttons. You can also stop the search process by clicking the 

Stop button. 

When the search process completes, the recovered file system is enlisted in the left panel. Select the file Click 
Next. 

All the folders within this file are listed in the left panel. You can expand the folders and view their details 
displayed in the right panel. 

10. Select and check the folders which you want to recover. 

11. Click Recover button. 

The software displays a dialog box asking you to provide the location for saving the recovered files. 
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Figure 4.9: Selecting Folder to recover for Extensive Scan Mode 

 

12. Specify the location to save the selected items and click OK button. 

When the saving process is done, the software displays a dialog box containing message regarding successful 
saving of files. 

13. Click OK button to close the dialog box. 
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Figure 4.10: Displaying successful saving of files in Extensive Scan Mode 

 

User can view the recovered files from the specified locations. 

 

4.3 Recover Data Using File Trace Mode 

The File Trace method is capable to recover those files that cannot be recovered with Quick Scan and Extensive 
Scan modes. With the help of raw scanning of the corrupted and damaged files, it recovers the data. 

Using following simple steps, recover the VHD files using File Trace method: 

1. Click Start > All Programs > Kernel for VHD > Kernel for VHD to launch the software. The welcome screen 
of the software appears. 

2. Browse and select the VHD file. 
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Figure 4.11: Selecting Recovery Mode for File Trace Method 

 

3. Select File Trace mode. The File Trace interface appears. 

4. Select Virtual Hard Disk from the left panel of the window. The detail of the virtual hard disk is shown in the 
right panel. 

5. Click Next to continue the recovery process. 
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Figure 4.12: Selecting Drive to Recover for File Trace Method 

 

A dialog box is displayed. Select the radio button Use existing partition info to recover data from an existing 
partition on the selected hard disk. Else, select Search partition option. 

6. Click OK to continue. 

The partition searching process takes place. You can stop the process in between by using the Stop button. The 
available partitions are displayed in the left panel. 

7. Click Next. 
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Figure 4.13: Selecting Partition to Recover for File Trace Method 

 

8. Click OK to continue. The File Types interface appears. 

 Note: You can select single or multiple file types for recovery. 

9. Check the files you want to recover from the File Types interface. 

10. Click OK to continue. Data searching process takes place. 
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Figure 4.14: Selecting File Types to Recover for File Trace Method 

 Note: You can show or hide the progress of the search process by clicking the Hide 

Progress/ Show Progress buttons. You can also stop the search process by clicking the 

Stop button. 

  

After successful completion of search process, the folders with all file types inside them are displayed in a tree-
like structure in the left panel. You can expand the folders and view their details displayed in the right panel. 

11. Select the file types that you want to recover. 

12. Click Recover button. 

The software displays a dialog box asking you to provide the location for saving the recovered files. 

13. Specify the location to save the selected items and click OK button. 
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Figure 4.15: Selecting path to save the recovered data in File Trace Method 

 

When the saving process is done, the software displays a dialog box containing message regarding successful 
saving of files. 

14. Click OK button to close the dialog box. 
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Figure 4.16: Displaying successful saving of recovered data in File Trace Method 

User can view the recovered files from the specified locations. 
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5. Download Purchase and Register 

5.1 Free Trial Download 

Kernel for VHD is available as trial version for FREE to download so that a user can analyze the features, 
functionalities, capabilities and can understand the complete working of the software. The trial version works 
almost same as that of the full version but with a limitation that it does not allow saving the recovered VHD 
files. To avoid this limitation, purchase the full version of the software.  

Free version of Kernel for VHD can be downloaded from our website: 

http://www.nucleustechnologies.com/download-vhd-recovery.html 

 

5.2 Purchase & Register 

Purchase the Full version of Kernel for VHD software for saving the recovered files and folders.  The FREE 
trial version of the software allows you to preview the recovered items but does not allow saving them. For 
saving the recovered items, purchase the complete version of the software. 

You can purchase the software through our website: 

http://www.nucleustechnologies.com/buy-vhd-recovery.html  (encrypted and secure site). 

 

Payment and Delivery 

 

Purchase the Kernel for VHD software from our authorized resellers, which provide number of payment options 
for your ease - Paypal, FAX, Credit Card, E-cheque, Pay Order, etc. 

After making the purchase transaction with our resellers, an email is sent consisting of activation details and 
download link of the Full version comprising of the activation code. This email is sent to the email address, 
which you have used while processing the purchase transaction with our resellers. 

We suggest you not to use false e-mail address while making the purchase transaction. 

For any other details related to purchase process, software activation process, email us 
at: sales@nucleustechnologies.com 

 

5.3 Support 

Lepide Software Pvt. Ltd. provides round-the-clock technical support for its product range to solve technical 
and software queries. The software comes with an embedded help manual that can be accessed by clicking 
Help in the software main window. You can also press the F1 key on the keyboard of your computer to access 
the embedded help manual of Kernel for VHD. 

Telephone Support: 

+91-9818725861 

http://www.nucleustechnologies.com/download-vhd-recovery.html
http://www.nucleustechnologies.com/buy-vhd-recovery.html
mailto:sales@nucleustechnologies.com
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1-866-348-7872 (Toll Free for USA/CANADA) 

Email Support: 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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6. Troubleshooting 

6.1 Common Issues 

What are the limitations in trial version of Kernel for VHD? 

The free demo version of Kernel for VHD works almost same as that of the full version of the software but 
with a limitation that it does not allow saving the recovered VHD files. 

 

6.2 Frequently Asked Questions 

1. How to purchase Kernel for VHD? 

One can buy Kernel for VHD from our website:  

http://www.nucleustechnologies.com/buy-vhd-recovery.html 

2. I have lost my full version for Kernel for VHD. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email 
address, and order confirmation number (if you have it). We will be happy to help you. 

3. What are the three recovery modes in Kernel for VHD? 

The three recovery modes for Kernel for VHD are Quick Scan, Extensive Scan, and File Trace. 

4. What are the supported Windows OS Platforms for Kernel for VHD? 

The supported Windows OS Platforms for Kernel for VHD are: Windows 8, Windows 7, Windows Vista, 
Windows XP, Windows 2000, Windows 2003, and Windows Server 2008/R2. 

5. What are the various reasons for corruption of VHD files? 

VHD files may get corrupted due to partition deletion, partition damage and partition formatting.  

6. Give the link for downloading the free trial version of Kernel for VHD. 

The free trial version of Kernel for VHD can be downloaded using the link: 

http://www.nucleustechnologies.com/download-vhd-recovery.html 

http://www.nucleustechnologies.com/buy-vhd-recovery.html
mailto:sales@nucleustechnologies.com
http://www.nucleustechnologies.com/download-vhd-recovery.html
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7. Legal Notices 

This section comprises the legal specification about Kernel for VHD and the company LEPIDE 
SOFTWARE Private Limited. 

 

7.1 Copyright Notice 

Lepide Software Private Limited, Kernel for VHD, accompanied user manual, and documentation are 
copyright of Lepide Software, with all rights reserved. Under the copyright laws, this user manual cannot 
be reproduced in any form without the prior written permission of Lepide Software. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© LEPIDE SOFTWARE PVT LTD. All rights reserved. 

 

7.2 Trademarks 

Kernel for VHD® is a copyright work of Lepide Software Private Limited. 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, MS Word® and Windows XP® are registered trademarks of 
Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective 
companies. 

 

7.3 Disclaimer 

The information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. Lepide Software Private Limited provides no warranty with regard to this manual 
or any other information contained herein and hereby expressly disclaims any implied warranties of 
merchantability or fitness for any particular purpose with regard to any of the foregoing. Lepide Software 
Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or 
typographical errors or omissions contained herein or for discrepancies between the product and the 
manual. 

In no event shall Lepide Software Private Limited be liable for any incidental, consequential special or 
exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with this 
manual or any other information contained herein or the use there of. 

 

7.4 License Agreement 

Kernel for VHD © by Lepide Software Private Limited. 

Your Agreement to this License 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

You should carefully read the following terms and conditions before using, installing, or distributing this 
software, unless you have a different license agreement signed by Lepide Software Pvt Ltd. The terms 
and conditions of this License describe the permitted use and users of each Licensed Copy of Kernel for 
VHD. For purposes of this License, if you have a valid license, you have the right to use a single Licensed 
Copy of Lepide. 

 

Scope of License 

Each Licensed Copy of Kernel for VHD may either be used by a single person or used non-simultaneously 
by multiple people who use the software personally installed on a single workstation. All rights of any kind 
in the Lepide, which are not expressly granted in this License, are entirely and exclusively reserved to and 
by Lepide Software. You may not rent, lease, modify, translate, reverse engineer, decompile, 
disassemble, or create derivative works based on, Lepide, nor permit anyone else to do so. You may not 
make access to Lepide available to others in connection with a service bureau, application service 
provider, or similar business, nor permit anyone else to do so. 

 

Warranty Disclaimers and Liability Limitations 

Kernel for VHD, and any and all accompanying software, files, data and materials, are distributed and 
provided as is and with no warranties of any kind, whether expressed or implied. In particular, there is no 
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates 
that any program, including Kernel for VHD, must be thoroughly tested with non-critical data before there 
is any reliance on it, and you hereby assume the entire risk of all use of the copies of Kernel for VHD 
covered by this License. This disclaimer of warranty constitutes an essential part of this License. In 
addition, in no event does Lepide Software authorize you or anyone else to use Kernel for VHD in 
applications or systems where Kernel for VHD Failure to perform can reasonably be expected to result in 
a significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to 
hold Lepide Software harmless from any and all claims or losses relating to such unauthorized use. 

 

General 

 
This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements, and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations, or representations made by Lepide Software herein. Any waiver by Lepide Software of any 
violation of this License by you shall not constitute, nor contribute to, a waiver by Lepide Software of any 
other or future violation of the same provision, or any other provision, of this License. 


